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National 
Electronic Open Meeting 

People and Their Governments in the Information Age 
May 1 to 14, 1995 

An Open Forum 
You're invited to participate in an open forum. 

t i l h 1l 
"The Office of Management and Budget ( OMB) seeks 
comments from all interested parties on the topic of the 
respective roles of the Federal government, State, local, and 
Tribal governments, industry, the public interest and library 
communities, academia, and the general public in creating 
an electronic government." 

The electronic open meeting will be held from May 1 to 14, 
1995. Below are excerpts from the document "People and 
Their Government In the Information Age." The excerpts 
we've chosen highlight how you can participate using your 
University Internet account. To receive the entire docu
ment, send a blank E-mail message to 

info@meeting.fedworld.gov 
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Excerpts from the Preliminary Agenda 
To facilitate public input, OMB, along with {several 
other departments} and assistance from the US 
Government Printing Office and the National 
Science Foundation's NCSA and SDSC Computing 
Centers, will host a nationwide electronic open 
meeting to discuss a number of questions. 

The world has entered the age of electronic infor
mation. We are present at the creation of a Global 
Information Infrastructure that will build on what 
aviation and communications have already done to 
shrink the world into ever more interdependent 
communities. 

While much of the infrastructure already exists, 
information will be so strategic a resource for U.S. 
competitiveness in the 21st Century that conscious 
and deliberate governmental action - in concert 
with industry and the public - is needed. Of 
course, government is in no position, financially, 
technically, or managerially, to design or build the 
information highway, or even to repave it. So the 
Nil {National Information Infrastructure} will be 
designed, built and operated by the private sector. 
What then is the government's role? 

One of the fundamental tenets of the Admin
istration's philosophy is that government informa
tion is a public asset and a valuable national re
source. The government should make information 
available to the public on timely and equitable 
terms. It is also necessary to foster the existing 
diversity of information sources, in which the 
private sector, along with State and local govern
ments, libraries, and other entities, are significant 
partners. 

{H }ow can the delivery of services to the public be 
enhanced by electronic means? What services 
should they be, and how can they be delivered cost 
effectively and within overall budgetary constraints? 
What methods are best suited to further dissemi
nate government information to the public, collect 
information from the public, and reduce burden 
while maximizing efficiency? In what ways can the 
interaction between agencies of the Federal govern
ment, or between agencies at the Federal, state and 
local levels be improved? How can we best encour
age partnerships among governmental entities at all 

levels with private sector entities to ensure a diver
sity of information sources, providers and facilita
tors? Finally, what are the priorities? These topics 
are elucidated further below for discussion in the 
electronic open meeting. 

Services 
from emergency help and health care 
to business licenses, 

Benefits 
from social security and food stamps 
to small business grants, 

Information 
from declassified secrets and travel aids 
to satellite weather maps, 

Participatory Democracy 
ensuring everyone's chance to be heard 
in a democracy, 

Technology 
Participation Options 

It is possible to participate in the electronic open 
meeting in four ways depending upon desired level 
of interaction. 

Electronic mall of comments 
This is the easiest way to participate in the open 
meeting. However, interaction will be limited. 
Choosing one of the options below is recom
mended. 

Subscribing to a Mailing List 
Subscribing to a mailing list allows more interactive 
participation in the meeting. When one subscribes 
to a mailing list, one receives all the mail messages 
which everyone posts to the mailing list. It is much 
like putting a note on a bulletin board. However, 
instead of having to go to the bulletin board to look 
for new messages, the bulletin board comes to you 
in the form of electronic mail. To subscribe to the 
National Electronic Open Meeting mailing list, 
send an e-mail to: 

join@meeting.fedworld.gov 

The text of the e-mail message should be: 

subscribe topic your_name 
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where the first word of the message must be the 
word "subscribe," the second word of the message 
must be the topic acronym, and the last two words 
of the message must be your name. The topic 
acronyms are: 

services 
infoaccs 

benefits 
part demo 

tech goal 

Services and benefits are obvious acronyms. 
"Infoaccs" refers to the "information" topic. 
"Partdemo" refers to the "participatory democracy" 
topic. "Techgoal" refers to the "technology" topic. 
For example, to subscribe to the "benefits" topic, 
an individual would send the message: 

subscribe benefits Joe Smith 
to 

join@meeting.fedworld.gov 

Individuals who subscribe to a mailing list topic will 
automatically receive (via e-mail) all comments 
posted to that topic. To submit a comment on a 
particular topic, send an e-mail message containing 
the comment to: 

topic@meeting.fedworld.gov 

where the "topic" is one of the topic acronyms 
detailed above. For example to submit a comment 
to the technology topic, send an e-mail message 
containing that comment to: 

techgoal@meeting.fedworld.gov 

Individuals using the mailing lists to participate in 
the conference should expect to receive a very large 
number of e-mail messages. 

Subscribing to a USENET newsgroup 
Subscribing to a USENET newsgroup is similar to 
joining a mailing list. The difference is that to 
subscribe to a USENET newsgroup, one needs to 
have a newsreader configured for his or her own 
computer. 

If you are familiar with a newsreader on your 
system, you will be able to participate in the 
newsgroups like any other regular newsgroup. The 
newsgroups have the following names: 

alt.gov.meeting.services 
alt.gov.meeting.benefits 
alt.gov.meeting.infoaccs 
alt.gov.meeting.partdemo 
alt.gov.meeting.techgoal 

World Wide Web Access 
Using a World Wide Web browser offers the great
est level of interaction for participating in the 
electronic open meeting. Point the browser to: 

http://meeting.fedworld.gov 

The participant will arrive at a user friendly interface 
from where one can search the different newsgroup 
mailing list responses and reply (either anonymously 
or not) as one deems appropriate. The participant 
will also be able to view background documents on
line, and complete a voluntary participant survey. 

~.-.--------------------------------------------------------~ ... 
University Offers Free Computer Access for National Meeting 

"The University Libraries is pleased to offer the 
citizens the opportunity to participate in the Clinton 
Administration's third national electronic meeting." 
University Libraries will provide the citizens of the 
Twin Cities with free access to designated comput
ers. The public can participate in the on-line discus
sion via public access computers on a first come, 
first served basis. 

The designated terminals and access times are: 
• Wilson Library terminals, Mon-Tues 9 am-8 pm, 
Wed-Fri 9 am-5 pm, Sat 1-5 pm eSt. Paul Library 
terminal, Mon-Thurs 8 arn-10:30 pm, Fri 8 arn-
8 pm, Sat 10 am-6 pm, Sun noon-10:30 pm. 
For further information call the Government Publica
tions Library, 624-5073, or the St. Paul Campus 
Library, 624-2233. 

~._•--------------------------------------------------~·~ 
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The Web and Web Browsers 

Hypermedia, Hypertext, and HTTP 
The World-Wide Web, 
WWW, or just "the 
Web" is a hypermedia 
information service 
that lets you access a 
lot of information that 
is available on the 
international Internet. 

• Hypermedia includes text, graphics, sounds, and 
moving pictures. The subset of hypermedia most 
frequently used on the Web is called "hypertext." 

• Hypertext documents are interactive and give the 
reader or viewer special control over what they 
access. These documents have highlighted words 
or phrases called links. When a reader selects a 
link, they are presented with another document or 
topic or even another program. 

In many ways hypertext links are like interactive 
footnotes that let you access the referenced informa
tion with a click of your mouse. 

Clients and Servers 
Like many Internet services the Web is a distributed 
system based on the client -server model. 

• Servers: organizations or individuals with comput
ers on the Internet can set up Web servers to 
provide information to other Internet users. 

• Clients: you use a program called a Web client to 
access information available on Web servers. 
Sometimes Web clients are referred to as "brows
ers." Clients and servers speak to one another 
using a set of communication rules (a protocol) 
called the Hypertext Transfer Protocol or HTIP. 

Despite the implications of its name, the Web is not 
the Internet or a network; it is a network information 
service that uses the infrastructure of the Internet to 
transfer data. 

There are client and server programs for many differ
ent computers and operating systems. All the clients 
operate in a similar fashion. You probably know the 
clients by names such as Mosaic, Netscape, Lynx, and 
MacWeb. Soon a Web browser will also be part of the 
Minuet package that we distribute. 

It's a Multi-Protocol World 
Many Web browsers include the ability to understand 
network protocols such as FfP and Gopher. Many 
also understand file formats used for graphics such as 
GIF and JPEG. This approach enables the user of a 
Web browser to access many services and types of 
files without acquiring additional software. 

When you do need additional software to manipulate 
the wide variety of information available electroni
cally, most Web browsers let you designate other 
programs as "helper" applications. Look for informa
tion on helper software that is supported by your 
browser in menus with names such as helper( s) and 
preferences. 

Need a Web Browser? 
You don't need your own browser if you'll access the 
Web using terminal emulation software such as 
ProComm, TinCan, or Xmodem. A text browser 
called Lynx is available through the maroon and gold 
mail shells (also called the "interactive session"). 
Lynx was described in our March 1995 newsletter. 

Software for Microcomputers 
If you have a direct connection or use SLIP with a 
2400 baud or faster modem, you can get software 
that runs on an IBM or a Mac. The novice may pick 
up free Web client software Monday-Friday in any 
Microcomputer HelpLine. Veteran netsurfers can 
obtain browser software at various FTP, Gopher, and 
Web sites. 

What's Out There? 
Once you connect to a Web server you are usually 
greeted with a Welcome page or a "home page." 
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Figure 1: Try These Web Sites 

University of Minnesota 
Distributed Computing Services 
Central Computing Services 

http:llwww.tc.umn.edul 

http:llwww.micro.umn.edul 
http:llwww.umn.edul-ccs 

Federal Web Locator 
City of St. Paul 
City of Minneapolis 
Yahoo 
Internet Search 

http:llwww.law.vill.eduiFed-Agencylfedwebloc.htmll 
http:llwww.stpaul.govl 

http:llwww.mtn.orglmplslcitylmpls_hp.htmll 
http:llwww.yahoo.coml 
http:llhome.netscape.comlhomelinternet-search.htmll 

That document should contain information about the 
group that is responsible for the "page" as well as 
information about their services; it may also include 
links to other relevant Internet sites. 

URLs 
You can use the list in Figure 1 to begin your explo
rations. Each entry contains the URL (Uniform 
Resource Locator) for a Web site. U-R-Ls are a 
naming scheme that includes the location and 
method of obtaining items on the Internet. Web 
URLs begin with this designator: http: I I 

Installing the Software 
If you're running other Internet software, such as 
Gopher or E-mail, your computer can already com
municate over the University's TCP /IP-based 
network. This hardwired (direct) or SLIP (modem) 
setup will also let you use a Web browser. 

If you need the Winsock driver discussed below or 
other software to connect to a TCP /IP network, a 
Microcomputer HelpLine consultant can help you. 

Mac and OS/2 
We have special installation instructions for users of 
OS/2. As long as their other network software is 
working, Mac users can install Web client software· 
without special instructions. 

Wlnsock for Windows 
Since most Windows users have not installed and 
setup Winsock drivers, they must do so before using a 
Windows-based Web browser, such as Netscape. 

Distributed Computing Services has created a special 
installation package for Windows users that greatly 
simplifies this step. The package requires two high
density 3.5-inch disks and is available at any Micro
computer HelpLine from 

p:windisk.bat 

The installation package and instructions on creating 
a disk are also available via anonymous ftp from 

bingo2.micro.umn.edu 
p:\internet\setupwin 

Web Installation Tip 
Since even at modem speeds of 14,400 bps (bits per 
second) graphics can take a long time to download, 
you may want to control which graphics you view 
on your screen. To speed up document transfers, 
many Web browsers let you turn off the automatic 
downloading of images; this option is usually in a 
menu with a name like preference or settings. 

Where Can I Get Training? 
Distributed Computing Services offers several low 
cost short courses on using the World-Wide Web 
and on setting up a Web server. For more informa
tion you can • call 625-1300 • look up information 
on the Web at http: I lwww. micro. umn. edul 
or • find info on Gopher by following this path 
from the University's Home Gopher: 

Computer Information/Computer & 
Information Services Short Courses 



Page 206 May 1995 Computer and ... 

Working Smarter with Word 6 
- Using Tables -

Have you ever used paragraph 
formatting to create pages with 
headers on the outside and col-

\

' umns of text on the inside, such as 
/ the example shown in Figure l? 

Have you tried to align columns of 
text or numbers with tabs (Figure 4 is 

an example)? Or would you just like to learn 
an easy way to enhance the look of your documents? 

You can use Word's tables feature to accomplish all of 
these things. You can create tables from existing text 
or enter information into a new table. You can alter 
the height and width of rows or columns and add 
borders and shading or even include a graphic. 
Whether you use Microsoft Word 6.0 for Macintosh 
or Windows, you can do all of these things. 

How Do I Create a Table? 
You can create a table in two ways: use menu com
mands or use the Standard toolbar. 

The Table Menu 
To insert a table into your document you can select 
the Insert Table command from the Table menu, as 
shown in Figure 2. In the Insert Table dialog box you 
can specify the number of columns and rows you 
want and how wide you want your columns to be. 

Figure 2: Insert Table Command 

Insert Table 

Number of Columns: I~¢ OK 

Number of Ro-ws: 12 lfil ( Cancel 

Column Width: !Auto I~ ( Wizard ... 

J 
) 
) 

Table Format: (none) ( AutoFormat ... ) 

Help ) 

You must specify the number of columns you want; 
specifying the number of rows is optional. After you 
have created a table you can always add another row 
by positioning the insertion point at the end of a row 
and pressing the (Tab! key. 

You do not have to specify how wide you want your 
columns to be. If Auto is in the Column Width text 
box, Word will automatically calculate column width 
based on the number of columns you have selected. 
Initially all columns will be the same width. You can 
change the width of individual columns later. 

Using the Standard Toolbar 
You can also insert a table by clicking on the Insert 
Table button on the Standard toolbar. Place your 
insertion point in the document where you want the 

Figure 1: Use Tables to Create Special Columns 

Researching 
Computers 
Computer Seect, a CD-ROM 

Available from: Business Reference 
Service, 624-9066 

Excerpts from February 1995 Computer and 
Information Services Newsletter article. 

This is a monthly disk containing full-text coverage of 
the most recent year's issues of PC Week and over 
60 other leading computer industry publications, as 
well as indexing and abstracts to over 100 other 
periodicals. 
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I~ I~ IBI~II.n 1·1 ~ 1·11~ ,., 
Documentl 

Fl&ure 3: 
Using the Insert Table Button 

repeat or update a heading if you 
insert a hard page break within a 
table. 

2 x 2 Table 

Moving Around In a Table 
The table in Figure 4 shows key
board combinations for moving 
around in a table. You can also use 
your mouse. 

the Standard toolbar, shown in Figure 3. When you 
use this button Word displays a grid representing the 
number of rows and columns a table will contain. As 
you drag across the grid, the number of rows and 
columns is represented in numbers at the bottom of 
the grid. Figure 3 shows 

What Does a Table Look Like? 
Figures 1 and 4 are tables. A table is a grid of rows 
and columns. A cell is one block in the table. This 
layout will be familiar to anyone who uses a spread
sheet. 

a two column, two row 
grid. Figure 4: Mouse and Keyboard Options 

My Table Is Split 
onto Two Pages! 
If, after you have fin
ished formatting a 
document, you find that 
your table is split among 
several pages, you can 
automatically repeat the 
table headings on each 
page. To do this select 
the row( s) of text that 
you want to use as table 
headings, beginning 
with the first row in the 
table. Then, from the 
Table menu choose 
Headings. 

If you make changes to 
headings in a table that 
splits between pages, the 
text will automatically 
be updated in all re
peated headings. How
ever, Word will not 

Key(s) 

Tab 

Tab 

Tab 

Tab 
at the 
end 
of a table 

Arrows 

Return; 
Enter 

Shift 

Home 

Page Up 

End 

Page 
Down 

Sh itt A It/ 
Option 

+ 

+ 

+ 

+ 

+ 

Control Return Results 
/Enta-

Moves to next cell. 

Moves to previous cell. 

+ Inserts a tab. 

Creates a new row. 

Moves from character to 
character within a cell. 

Creates a new paragraph 
within a cell. 

+ Inserts a line break within 
a paragraph. 

Moves to the first cell in 
a row. 

Moves to top cell in 
current column. 

Moves to last cell in 
current row. 

Moves to last cell in 
current column. 
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Figure 5: End-of-Cell and End-of-Row Markers 

You can manipulate tables by individual cell, row, 
column, or as one complete unit. The table's gridlines 
are non-printing separators between row and col
umns. Gridlines are visible only on your screen and 
only if you select Gridlines from the Table menu. 

End-of-Cell markers indicate the end of a cell. End
of-Row markers guide the positioning of the insertion 
point to add a column to the right of the table. As 
you can see in Figure 5, the two kinds markers have a 
similar appearance. 

To view or not view End-of-Cell and End-of-Row 
markers, click on the Show/Hide 1 button on the 
Standard toolbar. 

you wish to change and then choose a command. 
Selecting text in cells is the same as selecting text in 
any other part of a document. Table l shows you 
how you can select parts of a table using the mouse 
and keyboard. You can also use Word's Table menu 
to select rows, columns, or the whole table. 

Table 1: Selecting Parts of a Table 

To Select 
a Cell 

a Row 

Do this 
Move the mouse pointer to the left end 
of the cell until it becomes a~ (right 
pointing arrow) and click the mouse. 
Move the mouse to the left end of the 
row you want to select. Click when the 
pointer becomes a ~. 

a Column Move the mouse to the top of a column. 
How Can I Change a Table? 
To modify tables you can add, delete, or move cells, 
rows and columns; use Cut/Copy /Paste and Drag 
and Drop. Before you modify a table, you first must 
select a part or all of the table. 

When the mouse pointer changes into a 
.!., click to select the column below the .!.. 

The units of a table you can work with are an indi
vidual cell, a contiguous block of cells, a row or 
column, or the entire table. Select the unit of a table 

Or press the @/[Option) key and click in 
any cell of the column. 

Entire Table Press the @/[Option) key and 
double-click in any cell. 

Multiple Cells, Rows or Columns 
Hold down the mouse button and drag 
it across the cells you want to select. 

l"' ( How Can I Learn More Abo~; Word 6's Tables? 
\ '. Distributed Computing Services offers hands- To find out. more about current course offerings or 
~ on non-credit courses on Microsoft Word for how to reg1ster, you can (1) call 625-1300 

Macintosh and Windows. (2) look up information on the Web at URL 

To register for "Intermediate Word: Tables for 
Macintosh or Windowsw you must have mas
tered at least the skills taught in our introduc
tion to Word class. 

http:/ /www.micro.umn.edu/ 
or (3) find info on Gopher by following this path: 

Computer Information/Computer & Informa

tion Services Short Courses 

, 
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Move Cells, Rows, and Columns 
You can modifY tables in several ways. When you 
move or copy cells, if you select only the text within a 
cell, Word adds the text to the new location. If you 
select the End-of-Cell mark as well as the text the , 
text you move replaces the existing text. 

Cut, Copy, Paste 
Using the Cut, Copy, Paste commands to modifY the 
contents of a table affects only the contents of cells, 
not the column or rows. For example, Word does not 
delete a row when you select a row and use the Cut 
command. It just removes the contents of the cells in 
that row. The now-blank row is still there. 

If you paste what you've "cut" to an area outside the 
table, Word creates a new table with the same dimen
sions. 

Drag-and-Drop 
You can move or copy selected text using Drag-and
Drop editing with a mouse just like you would on 
normal text. You can move or copy rows; you cannot 
move or copy columns. 

How to Drag-and-Drop? 

To move text you've selected, position 
the mouse pointer anywhere over the 
selected area. When It changes to a left 
facing pointer, hold the mouse button 
down and drag the selection to a new 
position. 

Sort 
Table's sort options are useful for many types of data. 
You can sort a table alphabetically, numerically, or by 
date based on the text in any of its rows or columns. 
Select the rows or columns you want to sort and 
choose Sort from the Table menu. This brings up the 
Sort dialog box, shown in Figure 6. 

Figure 6: Table Menu's Sort Dialog Box 

Sort 

18 @Ascending Type: 
0 Desce ndi ng 

18 jText 
@Ascending Type: , ... , 
0 Desce ndi ng 

n~en tl9----------------------. 
I 

rMg List Has 
0 Header Ro'w' 

18 nnw: lr~xt 

@ No Header Ro'w' 

@~x..e~~~ f!9 , ... , 
0 Dv~.~.:~nd'i ng 

t OK J 
( Cancel ) 
( Options ... ) 
[ Help ) 
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Change the Size of a Table 
When you insert a table into a 
document without specifying its 
size, Word applies the default size 
settings. 

To change a table's appearance 
you can adjust any column's width 
and change the blank space be
tween columns. You can even 
adjust a row's height. To control 
these aspects of a column's appear
ance you use the Table menu's Cell 
Height and Width commands, as 
shown in Figures 7a and 7b. 

Adjust Column Width 
You can adjust the width of 
columns in many ways; we'll step 
you through a few options. When 
you adjust the width of one 
column, Word does not change 
the overall width of the table. It 
does, however, resizes all columns 
to the right of the column you 
changed in proportion to their 
original width. 

To change the width of a column 
with the mouse, follow these three 
steps: 

• put the mouse pointer over the 
column border until it be
comes a two-headed arrow 

• hold down the mouse button 

May 1995 Computer and ... 

Figure 7a: Column Adjustment Options 

Cell Height and Width 

Ro'w' T Column l 

ilt OK 
Width of Column 1: l•il ... ( Cancel 
Space Bet'w'een Columns: 1 o.15" I~ ( Auto Fit 

(Previous Column) ( Next Column ) ( Help 

Figure 7b: Row Height Adjustments 

Cell Height and Width 

Ro'W' Column 

I~ € 
Height of Ro'w's 1-5: OK 
!Auto 1 ... 1 At: ... ( Cancel 

, 
) 
) 

) 

J 
) 

Indent from Left: I o .. I~ ( Previous Ro'W' ) 
lignment 
@Left Qcenter QRight ( Next Ro'W' ) 

[8]Allo'w' Ro'w' to Break Across Pages ( Help ) 

Adjust Row Height 

• wait until Word displays a dotted line, then drag 
the mouse to the right or left. 

The height of each row in a table usually depends on 
two factors: the contents of the cells in that row and 
the amount of paragraph spacing. You can change 
the "auto" adjustment by using Cell Height and 
Width commands, as shown in Figure 7b. You can also change the column width of selected 

columns through the Table menu's Cell Height and 
Width commands, as shown in Figure 7a. Type a 
value in the box next to Width of Column or select a 
value by clicking on the up and down arrows. 

Add Columns to the Right of a Table 
To add a column to the right of a table that's already 
been created, select the End-of-Row marker (shown 
in Figure 5 ). Then either select the Insert Columns 
command from the Table menu, or click on the Insert 
Columns button on the Standard toolbar. 
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Add or Delete Cells, Rows, and Columns 
The Table menu includes commands for deleting and 
inserting items. Your options depend on which part 
of the table you've selected. 

Merge or Split Cells 
You can merge and split cells; both options are 
available in the Table menu. The merging cells option 
is useful for creating headings in tables. Select the 
adjoining cells that you want to merge, and choose 
the Mer:ge Cells option. This joins the cells you 
selected into one, long cell. 

Format Tables 
You format text and apply styles in table cells as you 
do with normal document text. Each paragraph in a 
cell can have unique formatting. Using the buttons 
on the toolbar you can change alignment, spacing, 
indents, and tabs. You can also change paragraph 
formatting by using the Format menu's Paragraph 
command. 

Use Borders and Shading 
Many people who create tables like to create borders 
and apply shades to some sections of the table. You 
can apply borders and shading through the Table 
menu. To do this position the insertion point in the 
table and choose Table AutoFormat. 

If you prefer to add your own borders and shading or 
want to add them to individual cells, you can use the 
Borders and Shading options in the Format menu or 
the Borders button on the Formatting toolbar. 

Split and Join Tables 
Use the Table menu's Split Table command to add a 
blank link between two sections of a table. To put the 
two parts back together, begin by highlighting the 1 
symbol between the two parts of the table. Then use 
the standard Cut command. 

Trouble Tip: 
Tables at the Beginning of a Document 
If you inserted a table at the very beginning of a 
document, you won't be able to put the insertion 

point before the table. However, you can use the 
Split Table command to insert a blank line above the 
table. To do this put the insertion point in any cell in 
the first row and select Split Table. 

Convert Existing Text to a Table 
You can convert an ordinary table that was created 
with simple tabs to Word's special Table format in 
two ways. You begin by selecting the text. Then you 
click on the Table button on the Standard toolbar or 
select the Convert Text to Table command from the 
Table menu. This "Convert" option toggles to 
Convert Table to Text when the text you've selected is 
already in the Table format. When you convert a 
table to text, you can specifY commas, tabs, or para
graph marks to separate or "delimit" the text. 

Delete an Entire Table 
You can delete an entire table by using standard keys, 
such as the [Del] (Delete) or [Bksp] keys. The only 
tricky part is that you must also select the paragraph 
mark either before or after the table. 

Is there an Easier Way to Make Tables? 
You can use a wizard to automatically create a table. 
A wizard is a Word feature that asks questions and 
then uses your answers to automatically format or lay 
out your document. You'll find a Wizard button in 
the Table menu's Insert Table option (Figure 2 ). 

Word Tables and Other Applications 
If you must exchange documents with other applica
tions, such as a different word processing program or 
a page layout program, the tables may not convert. 

To get the tables in this article into PageMaker, we 
needed to "publish" them as PICT files using Word's 
Edit menu. Then we subscribed to them using 
PageMaker's Edit/Editions menu. (Publish and 
Subscribe are features of System 7 for Macs. Word 
and PageMaker also support OLE, object linking and 
embedding.) 
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University Libraries' Gopher 
Opens New Doors to Research 

Nancy K. Herther, University Libraries 

Have you noticed how complicated 
it's become to keep up-to-date on 
what's available over the Internet 
in areas related to your research? 
The Internet is a virtual Pandora's 
Box - for good and bad. Faculty 
often complain that although there 
are lots of excellent resources 

available, trying to keep up-to-date 
and weed through resources to get at 

the best material is cumbersome. The Libraries hopes 
our new Gopher will help you with this task. 

Two Goals 
The Libraries formed a design group over a year ago 
to explore how we might best use Gopher to enhance 
and extend our services. Led by Jim Cogswell, from 
Wilson Library, the group determined to use Gopher 
to accomplish at least two important goals: 

l. bring Internet resources more easily into the 
hands of our University users and 

2. give us another way to share information -
handouts, bibliographies and other guides - that 
we develop for our users. 

Over the past year this project has become a reality. 
A list of the current team working on our Gopher is 
given in Table l. Feel free to contact any of these 
people with your ideas or suggestions. The Gopher is 
a work-in-progress and you should be seeing en
hancements, changes and improvements occurring 
each time you 'visit' the Gopher. 

Getting Into Gopher 
To visit our new Gopher service follow this path 

Libraries\ University of Minnesota 
Libraries\University of Minnesota Libraries, 
University of Minnesota\Subject List of 
Information Resources 

As you can see from the menu in Figure l, we have 
organized the Gopher by subject to allow for general 
browsing and yet allow for searching by subject 

terms as well. Those of you with 

Figure 1: General Information Screen for Libraries' Gopher 
your own Gopher client, such as 
TurboGopher or Minuet/ 
Gopher, can reach our Gopher 
directly; its address is: Subject List of Information Resources 

About this Directory (U of MN Libraries) 
SEARCH Menu Titles in the Subject List 
Agriculture, Biology, Ecology 
Archives and Special Collections 
Area Studies 
Arts and Humanities 
Engineering, Math, Physical Sciences 
Government Information 
Health Sciences ( U of MN BioMed Library Gopher ) 
International (Cross-disciplinary) 
Law 
Maps 
Media (audio, video, etc.) 
Newspapers 
Reference Tools (Dictionary, Thesaurus, etc.) 
Social Sciences 

cutter.lib.umn.edu 

Search by Topic 
If you know your interest areas 
and just want to see what's in the 
system, go directly to that subject 
area. All of the bibliographers and 
other specialists in the Libraries 
are cooperating to make the 
Gopher a good resource for 
finding information on our 
collections and databases. You 
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Figure 2: General Menu 
for Information on Astronomy 

Physics and Astronomy 

About this Directory (U of MN Libraries) 

** This Directory Currently Under Construction ** 
*************** Watch Your Step! **************** business with the former Soviet 

republic to statistical resources to 
geographic, political science, 
economic, literary and artistic 
information. 

Local Information - U of Mn Libraries 
Electronic Journals 
Other Resources 
Archives 

will find that many- if not most - of what used to be 
printed guides to our collections, background infor
mation on our CD-ROMs and other resources, etc., 
are now available as text files for your use. You 
should find this useful as you develop your syllabi and 
other course materials. 

Search by Subject Term 
Just to see what's out there, I tried two subject term 
searches. 

First, I tried "Astronomy" and found a variety of 
useful information. General information on the 
collections, resources and reference services available 
from the University Libraries was given, including 
e-mail addresses, phone numbers, locations and hours 
of service. I was able to connect to preprint collec
tions and electronic journals in astronomy available 
over the Internet. The Library Gopher also provided 
links to physics Gophers and to the Hubble Space 
Telescope Information server (Figure 3). Astronomy 
may not be my specialty, but I spent two intriguing 
hours browsing through these fascinating resources. 
Give it a try! 

Next I tried a current events type of search, looking 
to see what the Libraries' Gopher might have on 
"Russia." I was directed to two unique guides to 
Russian information, both developed here at the 
University by Miranda Beaven Remnek, our Bibliog
rapher for Russian/East European Studies. The first 
was an annotated listing of over l 00 print resources 
available for referencing everything from doing 

The second guide listed all of the 
significant on-line resources

whether from CD-ROMs on campus, over the 
Internet or databases accessible through LUMINA
that cover Russia from dissertation research to agri
culture to medical research to zoology. 

What student working on a short paper couldn't find 
useful information in Stephen Batalden's "The Newly 
Independent States of Eurasia: Handbook of Former 
Soviet Republics" published in 1993? It's available in 
the reference department in Wilson Library. 

Figure 3: General Menu Screen 
for Hubble Space Telescope Information 

Hubble Space Telescope Information 

About This Gopher 
STEIS Search Tools 
Gopher and WAIS Information 
Astronomical Internet Resources 
HST Archive 
STSci Documents 
Exploration In Education (ExinEd) 
OWNER 
README 
STEIS WWW Top Level 
cdbs 
instrument_news 
listserver 
meetings 
new_items 
observer 
pasp 
policy 
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Figure 4: More Internet Resources on Astronomy Thinking of setting up shop in 
Moscow? Then you'll want to 
check out these titles, available in 
Business Reference Service in 
Wilson: 

Astronomical Internet Resources 

About Astronomical Internet Resources 
Software Resources 
Publication Resources 
AAS Job Register 
AAS Meeting Abstracts 
AAS Summer 92 Meeting 
AAS Summer 93 Meeting 
AAS Winter 93 Meeting 
AXAF Science Center - ASCinfo 
American Astronomical Society 
Anglo-Australian Observatory 
Arecibo Observatory 

Facility 

"Evaluating, and Using Business 
Information from the Soviet 
Region" by Karen Anderson and 
Jonathan J. Halperin. 

"Doing Business in the Soviet 
Union" from Price-Waterhouse, 
1989-. 

Australian National Telescope 
Big Bear Solar Observatory 
CNAM (National Conservatory of 
Canada France Hawaii Telescope 
Canadian Astronomy Data Center 

Arts & Works) 

"Eastern European Business 
Directory," 1991-. 

Centre de Donne'es astronomiques de Strasbourg (CDS) 
Or perhaps you just get a little 
confused with the changing cast of 
politicos? You might want to take 
note of this title to help keep 

Table 1: 
Members of the Library Gopher Group 

The Library Gopher Group is responsible for the 
design and content of the Gopher. The members 
of this group are: 

Jim Cogswell, Chair 
j-cogs@vrnl.spcs.umn.edu 

Bill Tantzen, Gopher Manager 
w-tant@vrnl.spcs.umn.edu 

Subject Area Liaisons: 
Agriculture - Richard Isaacson 

r-isaa@vrnl.spcs.umn.edu 
Archives/Special Collections - Bruce Bruemmer 

b-brue@vrnl.spcs.umn.edu 
Arts/Humanities - Marcia Pankake 

m-pank@vrnl.spcs.umn.edu 
Engineering/Math/Science - Gary Fouty 

g-fout@vrnl.spcs.umn.edu 
Health Sciences- Julie Kelly 

j-kelll@vrnl.spcs.urnn.edu 
Law School - Suzanne Thorpe 

s-thor@maroon.tc.urnn.edu 
Social Sciences - Mary Koenig Loring 

m-koen@vrnl.spcs.umn.edu 
Staff Information/Tools - Christina Meyer 

c-meye@vrnl.spcs.umn.edu 

who's who straight: "Who's Who in Russia and the 
New States." It's edited by Leonard Geron and Alex 
Pravda, published in 1993, and available in the 
reference room on first floor Wilson Library. 

Give It a Try 
As you can see, we are working to make this Gopher 
an important resource for our users - a way to get 
information to you when, where and in a manner 
that will be most useful for you. 

Give it a try and let us know what you think. Re
member, it is a work-in-progress and it will continue 
to evolve and change over time. Check out the list 
of people in Table 1 and let them know what you 
think about our new project and what you'd like to 
see in the future. 

Nancy K Herther, Manager, Integrated Informa
tion Center, University of Minnesota Libraries, 
7 Walter Library, East Bank; 624-2020; Internet: 
nherther@iic.lib.urnn.edu. 
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Free Help: Computing Be Information Technologies 
University of Minnesota Accounts Phone Help Line Hours 

Distributed Systems: Microcomputers, Workstations, LANs 
Software, hardware, peripherals, local area networks ................................. 626-4276 ...... M-F ...... 9 am to 4 pm 

0 East Bank ......... 152 Shepherd Labs .................................................. above ............. above ..... above 
0 West Bank ........ 93 Blegen .................................................................. above ............. above ..... 1 pm to 4 pm 

0 St. Paul ............ 58 Biological Sciences Center .................................. above ............. above ..... 1 pm to 4 pm 

Central Systems 
These systems require a user name and password, which you get when you open an account. 

Qualified users can apply for grants to cover some computing related costs. 
0 EPX (Unix), NVE (NOS/VE), UZ (Uitrix), VX and VZ (VMS) ..................... 626-8366 ...... M-F ...... 9 am to 4 pm 
0 VM1 (IBM/CMS) 998 Coffey Hall walk-in consulting hours may vary .... 624-6235 ...... M-F ...... 9-11 am, 2-4 pm 
0 MEDLINE (MinnesotaMEDLINE on NVE) ............................................... 626-8366 ...... M-F ...... 9 am to 4 pm 

E-mail and Internet 
0 Call for help using your University account.. ........................................ 626-7676 ....... M-F ...... 9 am to 4 pm 
0 Forgot your password? Staff: call 626-8366. Students: go to any Computer Facility- e.g., 14 Folwell, 26 lind, 

305 McNeal, HHH 50. Troubleshooting: if Maroon or Gold are down, you'll hear a status report at 626-1819. 
0 LUMINA: call if you have trouble connecting ....................................... 626-7676 ....... M-F ...... 9 am to 4 pm 

General Information 
Computer Store 
Williamson Hall Book Center ............................. 625-3854 

(inventory and prices also available on Internet Gopher) 

University Computing Be Information Services 
Administrative Information Svcs. (AIS) Help desk ... 4-0555 
Biomedical Graphics, various locations .................. 6-3939 
Central Computing Services, 100 LaudCF ............... 6-1600 

Accounts: EPX, NVE (incl MEDLINE), UZ, VX, VZ .. 6-8366 
Data Entry .......................................................... 6-8351 
Statistics Services ............................................. 5-2303 
System Status .................................................... 6-1819 
Tape librarian .................................................... 6-1838 

Computer Facilities (also call individual facilities) .. 5-1300 
_FoiH 5-4896 _Lind 6-0856 _MeN 4-5367 _HHH 4-6526 +more 
Disability and Computing Services, voice/TTY ........ 6-0365 
Distributed Computing Services, 190 Shep Labs .... 5-1300 
Engineering Services, 103 LaudCF ......................... 5-1595 

Equipment Repair and Warranties ...................... 5-1595 
Faculty Resource Center (for appointment) ............. 5-1300 
Gopher Hotel (server set up for a fee) .................... 5-2303 
Kodak Printer Service ............................................. 6-1661 
St. Paul Computing Services, 50 CofH .................... 4-7788 

Accounts: VM1 (IBM/CMS) ................................ .4-7788 
Tape librarian .................................................... 4-3482 
Statistics Services ............................................. 4-6235 

Software Services (contract programming) .............. 5-2303 
Supercomputer Center Help, 3030 SCC ................. 6-0808 
Telecommunications, 30 TelecomS 

Networking Services Information ........................ 6-7800 
Networking Services Repair ................................ 5-0006 

Training, Course Registration, 190 Sheplab .......... 5-1300 
U libraries, Integrated Information Center .............. 4-2020 
University Networking Services, 130 Lind ............... 5-8888 

Associate Vice President and 
Associate Provost Academic Affairs 

Donald R. Riley, Professor ............................. 626-9816 

Access Information 
SLIP: 2400/14,400--------- 626-1920 
SLIP: ADI-100 and ITE (with MKO) 3-0291 

'S Terminal settings for 
these systems are 8-1-N 
(8 data bits, 1 stop bit, 
no parity) unless other
wise noted. The number 
you dial may depend on 
the modem's bps or 
baud rate. 

0 Internet addresses. 

0 Dial-in Server: 626-0300, 
-1200, -2400, -4800, -9600 

0 At 9600 Telecomm 
supports V.32 and MNP 
level 5 error correction. 

0 On campus ADI-100 and 
ITE setups use 626-2400. 

LUMINA: 300/1200/2400 ........................ 625-6009 'S 
V.32 ........................................................... 4-7539 'S 
Telnet & tn3270 PUBINFO.AIS.UMN.EDU 0 

E-mail and Internet Service and Servers, Twin Cities 
MAROON. TC. UMN. EDU GOLD. TC. UMN. EDU 0 

Gopher, alternate access (log in as gopher) 
300, 1200, 2400, 9600 ............ see Dial-in Server S 
----------- CONSULTANT.MICRO.UMN.EDU 0 

Consulting via E-mail: low priority Central System ques 

Format _ CONSULT@MACHINE. NAME. UMN. EDU 

AIS SecureiD V.32 ...................................... 626-1061 'S 
300/1200/2400 ......................................... 6-7770 'S 
tn3270 & Tel net__ ADMIN. AIS. UMN. EDU 0 

EPX, NVE (includes MEDLINE), UZ, VX, VZ 

300, 1200, 2400, 9600 ............ see Dial-in Server 0 
EPX or UZ or VX or VZ or NVE. CIS. UMN. EDU 0 

EPX, NVE: 300/1200/2400 ...................... 625-1445 'S 
up to 19.2 campus data phone .................. 3-2400 S 

VM1 (IBM/CMS) at 7-1-even 

96oo ..................................................... 624-3668 a 
1200/2400 & <19.2 campus data phone .. 4-4220 a 
___________________ VMl.SPCS.UMN.EDU 0 

Trademarks: Internet Gopher and POPmail are registered trademarks of the University of Minnesota. 
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